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About the Asymetrix Setup Utility
Using the Asymetrix Setup Utility

The Asymetrix Setup Utility allows you to produce a setup program that users can run to install your application. 
The Asymetrix Setup Utility has two parts:

The Setup Manager (SETUPMGR.EXE), a ToolBook application you use to create an installation script 
(.ASU file) identifying the files to install and other installation options, and to create a set of distribution disks.

The Setup program (SETUP.EXE), which users run to install your application.
You can use the Asymetrix Setup Utility with applications produced using any development tool or language.
When you use the Setup Manager to create an installation script and a set of distribution disks, you can choose to 
use two modes:

Wizard mode, in which the Setup Manager presents a set of screens that prompt you for basic information 
about your application setup. Wizard mode is easy to use, but does not offer as many options as Expert mode.

Expert mode, in which you use a set of dialog box tabs to specify detail about your applications installation 
options. Expert mode can be more complex to use than Wizard mode, but allows you to take full advantage of the 
Setup Managers capabilities.
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About the installation script
Using the Asymetrix Setup Utility

The installation script is a set of instructions the SETUP.EXE program reads to know how to install your 
application. For example, you can specify the files to be included in the application, the destination directory on the
user's system, and actions that are to take place when the installation is complete (such as displaying a message).
The user can choose which components of the application to install.
You use the tabs in SETUPMGR.EXE to develop the instructions, which are stored in a text file with the 
extension .ASU (Asymetrix Setup Utility). For details on what goes in the installation script, see 
The installation script can become quite complex. It's important to test it thoroughly before distributing your 
application. For details on what goes in the installation script, see Installation script layout
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Using the Setup Manager in Wizard mode
Using the Asymetrix Setup Utility

In Wizard mode, the Setup Manager presents a set of screens that prompt you for basic information about your 
application setup. Wizard mode is easy to use, but does not offer as many options as Expert mode. Wizard mode 
is the default; when you start the Setup Manager or choose New from the File menu, you automatically start the 
Setup Manager Wizard.
To use Wizard mode, respond to the prompts in each of the screens described below, then click Next to move to 
the next screen:

Screen Information you provide
Files And Directories In Your Application The name of the Windows Program Manager group that your 

application will appear in when installed, and the directory tree 
containing the files you want to include as part of your 
application.

Runtime Files To Include With Your Application Whether to include Runtime ToolBook with your application, and
if so, what other files (such as DLLs) to include.

Conditions For Installing Files What to do if the user already has a copy of Runtime ToolBook 
installed.

Icons And Program Items The icons that will appear in the Windows Program Manager 
group that Setup program creates, and what command each 
icon will execute when clicked.

Splash Screen What bitmap to display at the beginning of the installation.
Message To Display At End Of Installation What text, if any, to display after installation is complete.
Creating The Installation Files And Disks The path where you want the Setup Manager to create the 

installation-ready files containing your application, and the 
medium on which you will be distributing the application (CD, 
1.44MB disks, and so on).

When you use Wizard mode, the following restrictions apply:

Your application is installed as a single component.

You can specify only one directory (and its subdirectories) as the source files for your application. All the files
required for your application must be in the specified directory or its subdirectories, and you cannot exclude any files. 

You cannot specify that SETUP.EXE launch any programs after installing your program, though you can 
have it display a message suggesting that the user do so. 

You can switch to Expert mode at any time by clicking Expert Mode. However, once you switch to Expert mode, 
you can no longer work with that installation script in Wizard mode.
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Using the Setup Manager in Expert mode
Using the Asymetrix Setup Utility

In Expert mode, you specify details about your applications installation options. Expert mode can be more complex
to use than Wizard mode, but allows you to take full advantage of the Setup Managers capabilities. 
When you start the Setup Manager or choose New from the File menu, you automatically start the Setup Manager 
Wizard. To use Expert mode, click Expert Mode in any screen while in Wizard mode. You cannot return to Wizard 
mode from Expert mode, and if you save your installation script while in Expert mode, you cannot then open it in 
Wizard mode.
In Expert mode, the Setup Manager consists of a dialog box with six tab sections. To go from one section to 
another, click the tab at the top of the dialog box. The tab sections cover the following information. 

Tab Information you provide
General Title for installation dialog boxes

Default directory for installation
Graphics that appear during installation

Files Component names
Files to include in each component
Total component size

PM Icons Program Group name
(for each installation component) Program Item description

Command line
Icon

Configuration
(for each installation component) Changes to be made to .INI, AUTOEXEC.BAT, and CONFIG.SYS files
Launch EXE
(for each installation component) Commands to be executed when installation is complete
Create Disks Drive and directory for distribution files

Name for distribution file set
Size of distribution disk

To create an installation script (.ASU file), fill in information for each tab, then save the file. After creating the 
installation script, you can create a set of distribution disks.
To edit an existing installation script, start the Setup Manager, then open the file. All of the values appear in the 
appropriate fields in the tabs. Make the changes you need, then save the file again.
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About setup flow
Using the Asymetrix Setup Utility

There are two parts to working with the Asymetrix Setup Utility. As the developer, you run the Setup Manager 
(SETUPMGR.EXE) to create an installation script (.ASU file) that specifies

how the setup program should appear to the user, including a backdrop and installation bitmap.

components of your application, including what files belong with each component, whether the component is
optional, and where the component should be installed. You can also include the Runtime version of ToolBook with 
your application.

Program Manager information for each component, including its group, icon, and the command line that is 
run when the user clicks that components icon in the Program Manager.

any programs that should be launched after installation is complete, such as Notepad to display Readme 
information or another installation program for third-party drivers.

Note If you use the Setup Manager Wizard to create your installation script, not all of the options listed above are 
available. 
When you have finished specifying options, you use the Setup Manager to create a set of distribution disks 
containing the installation files, the installation script, and the SETUP.EXE program.
To install your application, the user runs the Setup program (SETUP.EXE) from the distribution disk. The Setup 
program reads the installation script, then displays a dialog box that

prompts the user for the destination directory.

provides a menu of components to be installed, allowing the user to choose which to install.

The following flow chart depicts the process, which takes place before the startup screen appears.
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About Runtime ToolBook
Using the Asymetrix Setup Utility

If you want users to be able to run your application but not make changes to it, you can distribute Runtime 
ToolBook with your application files. Runtime ToolBook is a special version of ToolBook or Multimedia ToolBook 
(TB40RUN.EXE or MTB40RUN.EXE) that

runs only at Reader level (users cannot switch to Author level).

does not display ToolBooks opening screen when started.

does not allow users to display Author-level tools such as the Script editor window, palettes, the Command 
window, or the Debugger window.

does not support right-click menus or the tool bar.
In addition, the value of sysLevel is always reader (and attempting to set it to author causes an error), and 
the values for rulers and sysGrid properties are always false because users cannot display the rulers or the 
grid. A number of commands, messages, and properties are not available and result in error messages when used
in Runtime ToolBook. For a complete list, see Features not supported in Runtime ToolBook.
Note The ToolBook license agreement allows you to distribute copies of Runtime ToolBook and some of the 
dynamic link libraries (DLLs) included with ToolBook. 
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Component Selection dialog box
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If the user chooses Custom Installation in the Installation Options dialog box, the Component Selection dialog box 
appears, which allows users to select the components to install and specify a different destination directory for the 
application.

Option Description
Component The list of components and their sizes. By default, all options are 

checked. To prevent the Setup program from installing a 
component, users must deselect it.

Destination Directory The destination directory for the installation. The default is stored 
in the installation script, but users can change this to any 
directory. If the directory doesn't exist, the Setup program creates
it.

Browse Users can click this to open a dialog box in which they select a 
drive and directory for the installation.

Change Runtime ToolBook 
directory

If users want to install Runtime files in a directory other than the 
default destination directory, they must click this button to open 
the ToolBook Runtime dialog box. If Runtime files were added 
manually as a component, this button does not appear in the 
dialog box.

Runtime ToolBook Destination
Directory

The directory in which the Runtime files will be installed. The 
default entry in this field is the path specified in the 
CommonComponent section of the installation script.

Disk Space The space required for a component, and the space available on 
the drive to which files are to be installed. The Required figure 
includes all selected components plus the Runtime files.

Continue After selecting the desired components, users click this to begin 
installation.

Go Back Users click Go Back to return to the Installation Options dialog 
box. Any selections already made ignored.
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Features not supported in Runtime ToolBook
Reference information

The following tables list the properties, commands, and messages that do not function in Runtime ToolBook. 
Unless otherwise noted, attempting to use these results in an error. 
At the end of this topic you will find a list of additional differences in behavior between the development and 
Runtime versions of ToolBook.

Properties
Attempting to set any of the following properties in Runtime ToolBook results in an error. You can get the value of 
some of the properties, as listed in the table.

Property Value in Runtime ToolBook
bounds of commandWindow, toolBar, any palette
position of commandWindow, toolBar, any palette
size of commandWindow, toolBar, any palette
startupAutoScriptFile Name of Auto-Script file
startupReaderRightClick false
style of toolBar, toolPalette
sysAutoScriptFile Name of Auto-Script file
sysGrid false
sysGridSnap false
sysGridSpacing
sysLevel reader
sysReaderRightClick false
sysRuler false
sysRuntime true
sysShowMRUFiles false
sysTool reader
tile of toolbar, toolPalette
tileOrder of toolbar, toolPalette
tileWrap of toolbar, toolPalette
visible of commandWindow false
visible of toolbar, any palette false

Commands
Attempting to execute the following commands results in an error in Runtime ToolBook:
edit script
sort (but not the sort message)
put command with commandWindow as the 
destination

Runtime ToolBook does not respond when you execute the following commands, but it does not display an error 
message:
add menu
add menuItem
check menu



check menuItem
disable menu
disable menuItem 
enable menu
enable menuItem
remove menu
remove menuItem
restore menubar
uncheck menu
uncheck menuItem
Any menu command that specifies at author

Messages
Runtime ToolBook displays an error if you attempt to send any of the following messages that display an Author-
level dialog box, manipulate the palettes or the grid, or change to Author level.
author
autoScript
backgroundProperties
bookProperties
color
command
contents
debugScript
editScript
file1, file2, file3, file4 (MRU 
file list aliases)
grid
importGraphic
keyboardShortCuts
learningToolBook
line
lineEnds
menuCommands
newViewers
openScriptReference
pageProperties
pageSize
pattern
polygon
properties
reader (ignored; no error)
resources
rulers
searchForHelpOn
showGrid



snapGrid
sort
startRecording
stepByStep
stopRecording
technicalSupport
tool
toolbar
viewers

Additional differences in Runtime ToolBook

Help buttons are removed in all built-in dialog boxes.

Instead of displaying the Execution Suspended message box when encountering an error, Runtime 
ToolBook displays the text of the error message in an Error message box. The user can see more information about 
the error by holding down the Ctrl key while clicking Cancel. Runtime ToolBook displays the Execution Suspended 
dialog box with all buttons removed except Cancel. 

If you start Runtime ToolBook without a file name
- ToolBook displays the Open dialog box to prompt you for the name of a .TBK file to open.
- Runtime ToolBook displays the copyright bitmap (no copyright bitmap is displayed if you specify a book 

on the command line).
- the default menu bar is the File menu with Open and Exit menu items.



About distribution disks
Using the Asymetrix Setup Utility

The Setup Manager produces master distribution disks that contain all the files needed for installation, the 
installation script (.ASU) file that specifies setup options, and the SETUP.EXE program. 

The first disk contains SETUP.EXE, the .ASU file, and any bitmaps that will be displayed during installation, as well
as the first compressed installation file. Subsequent disks, if needed, contain additional parts of the compressed 
installation file.
You can distribute your application on any size floppy disk, on CD-ROM, or on a network drive.
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Including Runtime ToolBook with your application
Using the Asymetrix Setup Utility

The Asymetrix Setup Utility allows you to distribute ToolBook or Multimedia Runtime ToolBook files with your 
application.

To include ToolBook or Multimedia Runtime ToolBook with your application:
(In Wizard mode)

In the Runtime Files To Include With Your Application screen, check the Basic Runtime ToolBook box.
(In Expert mode)

In the Setup Manager's Files tab, click Add Runtime. The Setup Manager adds a component called 
[CommonComponent] to the installation script in the .ASU file you are creating.

Alternatively, you can create your own Runtime component in the same way as any other component. This allows 
you to call it whatever you want, and have it installed in whatever directory you specify, regardless of whether 
there is another copy of Multimedia Runtime ToolBook on the system (unless the user changes the directory or 
chooses not to install the component). If you create your own Runtime component, you must be sure to include all 
necessary files. For a list of Runtime files, refer to the list in FILELIST.WRI.
For complete information about how SETUP.EXE determines where to install the [CommonComponent], see About
Runtime ToolBook installation.

Distribution tips
For best results when distributing ToolBook or Multimedia Runtime ToolBook with your applications, follow these 
guidelines:

Include the Runtime ToolBook using the procedure above rather than creating your own Runtime 
component. This assures that your application will work with other ToolBook applications that your end users have 
installed, and avoids installing redundant copies of the Runtime files, saving space on users' systems.

When using the Add Runtime feature in Expert mode, use all of the standard .INI file modifications that come
with it, which further assures that your ToolBook application will work correctly with other ToolBook applications.

Do not change the value of startupSysBooks in the TB40.INI or MTB40.INI files, because you can cause 
other ToolBook applications to stop working correctly. If your application depends on particular system books, push 
them onto the sysBooks property in an enterApplication handler.
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Adding custom percentage-complete bitmaps
Using the Asymetrix Setup Utility

The Setup program displays a message indicating (by percentage) how far along the installation is for the current 
file and for the application as a whole. You can also display a custom percentage-complete bitmap.
To do so, edit the installation script (.ASU file) after creating it, using a text editor such as Windows Notepad. Add 
a Bitmap instruction to the [General] section of the installation script to display bitmaps at various points in the 
installation process.
Syntax: Bitmap<X> = BitmapName,Alignment,StartPercentage,EndPercentage

Parameters: BitmapName
A string representing the path to bitmap file.
Alignment
One of the following strings indicating where the bitmap should be displayed (these are the same as 
those supported for displaying the background bitmap, except that Tiled and AllTiled are 
ignored):

Centered
UpperLeft
UpperRight
LowerLeft
LowerRight
CenteredLeft
CenteredRight
UpperCentered
LowerCentered

StartPercentage
An integer indicating what percentage of the application should be complete before this bitmap is 
displayed.
EndPercentage
An integer indicating what percentage of the application installation should be complete when the 
bitmap is removed.

Example: Bitmap0=c:\windows\regnote.bmp,UpperRight,0,25
This example displays the bitmap regnote.bmp in the upper-right corner of the screen from the beginning of 
installation until installation is 25 percent complete.
You can use more than one Bitmap<X> instruction to have different bitmaps appear in sequence. The instructions
would be numbered Bitmap<0>, Bitmap<1>, and so on.



Asking users about installing components
Using the Asymetrix Setup Utility

You can have the installation process ask users yes-or-no questions about whether to install individual 
components. This allows you to substitute a question for the Component Selection dialog box, or to confirm a 
user's selections.

To do so, edit the installation script (.ASU file) after creating it, using a text editor such as Windows Notepad. Add 
Query instructions to each component section in the installation script.

Syntax: Query Condition, Text
Parameters: Query Condition

A string containing one of the following keywords:
IfSelected The question is asked only if the user has selected the component for 

installation
IfNotSelected The question is asked only if the user has not selected the component 

for installation
Always The question is always asked, regardless of whether the component is 

selected for installation
Text
A string containing the contents of the message box. The question should be phrased as a yes/no 
question, and so that a "yes" answer means the component will be installed.

Example: Query = IfNotSelected, "The main executables are not selected to 
be installed. Do you want to install them at this time?"

In this example, if the component is not selected for installation, the message appears and the user can answer by
clicking Yes or No in the message box. The user's response to this query overrides any earlier selection regarding 
installation of the component.



File menu
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New
Creates a new installation script (.ASU file). If the current file has changed since you last saved it, you're prompted
to save it.

Open
Opens an existing installation script (.ASU file). If the current file has changed since you last saved it, you're 
prompted to save it.

Save
Saves your work. If this is the first time you are saving an installation script, the Save As dialog box appears to 
allow you to assign a name to the .ASU file.

Save As
Saves work that hasn't been saved before, or saves the current installation script under a new name.

Exit
Quits the program. If the current file has changed since you last saved it, you're prompted to save it.



Edit menu
Reference information

Cut
Removes the highlighted text and places it on the Windows Clipboard.

Copy
Puts a copy of the highlighted text on the Clipboard.

Paste
Places the contents of the Clipboard at the insertion point, or replaces highlighted text.

Clear
Removes the highlighted text without putting it on the Clipboard.



Adding custom button bitmaps
Using the Asymetrix Setup Utility
The Setup Manager automatically specifies a default bitmap to be used on the Full, Custom, and Exit buttons in the 
Installation Options dialog box. However, you can specify your own bitmaps for these buttons by entering one or more
of the following lines in the [General] section of the .ASU file.

Script line Description
FullInstallBMP=<path\name.bmp> Specifies the bitmap for the Full installation button
CustomInstallBMP=< path\name.bmp> Specifies the bitmap for the Custom installation button
ExitInstallBMP=< path\name.bmp> Specifies the bitmap for the Exit button

The parameter <path\name.bmp> is the path and name of the bitmap.

SETUPMGR.EXE automatically adds the following line to the General section of the installation script:
FullInstallBMP=DEFAULT
This line causes the custom Installation Options dialog box to be displayed.
If you delete this line, the standard Windows Installation Options dialog box is displayed.
You can also replace any or all of the default button bitmaps in the custom dialog box with bitmaps of your own 
choice by adding the following instructions.

Script line Description
FullInstallBMP=<path\name.bmp> Specifies the bitmap for the Full installation button.
CustomInstallBMP=< path\name.bmp> Specifies the bitmap for the Custom installation button.
ExitInstallBMP=< path\name.bmp> Specifies the bitmap for the exit button.

The parameter <path\name.bmp> is the path and name of the bitmap.



Installation Options dialog box
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During installation, the Installation Options dialog box appears after the startup bitmap disappears. Users can 
choose the type of installation (full or custom) and specify a different destination directory.

Option Description
Full Users click this to install all components.
Custom Users click this to open the Component Selection dialog box and 

choose the components to install.
Exit Users click this to exit from the installation program.
Destination Directory Users enter the destination directory for the installation. This path

and directory are set initially by the SETUP.EXE from information 
in the installation script (.ASU file). Users can specify any 
directory; if the directory does not exist, SETUP.EXE creates it.

Browse Users click this to open a dialog box in which they select a drive 
and directory for the installation.
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About Runtime ToolBook installation
Using the Asymetrix Setup Utility

If an installation script (.ASU file) contains a component labeled [CommonComponent], the Setup program installs 
Runtime ToolBook or Multimedia ToolBook in a predetermined directory. If the Setup program detects an existing 
copy of Runtime ToolBook or Multimedia ToolBook, it overwrites the files. 

However, if the existing copy of Runtime ToolBook or Multimedia ToolBook is in another language (such as 
German or French), the Setup program creates a new directory for the version of Runtime ToolBook or Multimedia 
ToolBook being installed.

Note    If you created your own component for Runtime ToolBook instead of allowing the Setup Manager to include 
Runtime files, the installation process cannot follow the procedure described here.

The following flowchart depicts the process, which takes place before the startup screen appears.
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Module registered?
Is the module (the Runtime version of ToolBook or Multimedia ToolBook) identified in the ASYM.INI file?



Registered path is default path?
Is the path of the module (the Runtime version of ToolBook or Multimedia ToolBook) in the ASYM.INI file the same as 
the default path specified in the .ASU file?



Same language?
Is the module (the Runtime version of ToolBook or Multimedia ToolBook) registered in the ASYM.INI file the same 
language (for example, English or German) as the one to be installed?



Create language-specific subdirectory
Create a subdirectory under the directory that contains the registered module. The name of the directory is the name 
of the language of the module to be installed (for example, \German or \English).



Install module files to default path
There is no other copy of ToolBook or Multimedia Runtime ToolBook in the same version and language on the user's 
system. Install the module (the Runtime version of ToolBook or Multimedia ToolBook) in the destination directory 
specified in the .ASU file.



Install module files to language-specific subdirectory
There is another copy of Multimedia Runtime ToolBook in the same version but a different language on the user's 
system. Install the new module (the Runtime version of ToolBook or Multimedia ToolBook) in a different subdirectory.



Install module files to registered path
There is another copy of Multimedia Runtime ToolBook in the same version and language on the user's system. 
Overwrite the existing copy of ToolBook or Multimedia Runtime ToolBook.



Register module, path, and language in the ASYM.INI file
Register the new module (the Runtime version of ToolBook or Multimedia ToolBook), path, and language in the 
ASYM.INI file.



Setup Manager (General tab)
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The General tab in the Setup Manager dialog box allows you to customize the look of the Setup dialog box that 
appears when users install your application.
Note The Setup Manager dialog box tabs only appear in Expert mode.

Note Click a tab below to see its options.

Option Description
Dialog Box Title Specifies the title of the dialog boxes that appear when the user installs your application (the

Installation Options and Component Selection dialog boxes).
Default Directory Sets the default path for the destination directory on the users computer in which you want 

the application to be installed. Click Choose to choose a directory from your own system. 
You can use directory placeholders in the path. The path you enter becomes the default 
value of the $install$ directory placeholder. 

Common Directory Sets the directory in which the ToolBook or Multimedia Runtime ToolBook files will be 
installed if you specify them as a CommonComponent. This copy of the Runtime files will be 
shared with future applications, so it is recommended that this directory be different from the 
destination directory for the application files. The user can change this directory at the time 
of installation. The path you enter becomes the default value of the $common$ directory 
placeholder. 

Startup Bitmap Specifies the path and name (on your system) of the bitmap that appears over the 
background gradient after the installation program finishes copying files to the temporary 
directory. (The startup bitmap is sometimes called the splash screen). The startup bitmap 
remains onscreen for the length of time you set or until the user presses any key or clicks on
the bitmap. To select a startup bitmap, click the Choose button.

Duration Sets the number of seconds the startup bitmap is displayed. If you set the duration to 0, the 
startup bitmap will remain onscreen until the user clicks a mouse button or presses any key.

Background Displays the specifications for the background screen that appears during installation. The 
screen can have a color gradient and a bitmap. The bitmap can appear as a single image or 
as multiple tiled images. To specify options for the background, click the Options button.

Options Displays the Background Options.

Note Bitmap colors are mapped to the nearest colors on the user's system. You'll get the best results if you 
convert bitmaps to the 16-color Windows palette.
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Background Options dialog box
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The Background Options dialog box allows you to specify the color of the gradient that appears behind the 
installation dialog boxes, and the alignment of the bitmap that should appear during installation (if any). A preview 
of your selections (with the bitmap reduced, not full size) is displayed in the dialog box.

Option Description
Gradient Sets the background color. If you choose Red, Green, or Blue, the color appears in a gradient 

from light at the top of the screen to dark at the bottom.
Bitmap Sets the path and name (on your system) of the bitmap. To select a bitmap, click the Choose 

button.
Alignment Sets the alignment for the bitmap. Choose No Bitmap if you don't want a bitmap, just a gradient. 

Choose Tiled to repeat the bitmap but leave a border. Choose All Tiled to repeat the bitmap so 
that it fills the screen.

Choose Opens the Select dialog box so you can choose a background bitmap. The path and name you 
choose are entered in the Startup Bitmap field on the General tab.
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Setup Manager (Files tab)
Reference information

In the Files tab, you can set up the components of your application, giving each component a name and selecting 
the files for it. Installation Component Names are the names of the components of your application, such as 
Library, Help, Editor, and so on. These names appear in the Component Selection dialog box, where the user can 
choose to install them or not.
Note The Setup Manager dialog box tabs only appear in Expert mode.

Note Click a tab below to see its options.

Option Description
Installation Component 
Name

Lists the names you give to the components of the application. The 
names appear in the Component Selection dialog box in the same 
order as they appear in this list box. To rearrange the components in 
the list box, click a component name and drag it to a new position in 
the list.

Total Component Size Displays the total number of bytes (uncompressed) of all files in each 
component. The size is calculated by SETUPMGR.EXE as you select 
files. When the user installs your application, this size appears in the 
Component Selection dialog box next to the component name.

Add New Prompts your for the name of a new component, then opens the 
Component File List dialog box, where you can choose files for that 
component.

Add Runtime Adds all ToolBook or Multimedia Runtime ToolBook files to your 
application, and opens the Add Runtime dialog box to allow you to add 
optional Runtime files. For details about adding Runtime files, see 
About Runtime ToolBook installation.

Change Name Changes the name of the selected component, prompting you for the 
new name.

Remove Removes the selected component, deleting all information associated 
with the component from the installation script (.ASU file). The files 
themselves are not deleted from your disk, but will not be included 
when you create a set of distribution disks.

Edit File List Opens the Component File List dialog box, where you can view and 
choose files for that component.
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Component File List dialog box
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In the Component File List dialog box, you can choose files for a component, set rules for when those files should 
be copied to the user's hard disk, and specify the directory to which they should be copied.

Option Description
File List Lists the files for the selected component.
Choose Files Opens the Choose Files to allow you to select files for the 

component.

Note    If you want to assign an icon to the component that will be 
displayed in a Windows Program Manager group when the 
application is installed, be sure to include the required .BMP 
or .ICO file as part of the component.

When to Copy Displays options for when to copy a particular file when the 
component is installed. The default is Always Copy. The options 
are:

Always Copy. Always copies the file. If there is 
a file with the same name in the destination directory, overwrites 
it without prompting.

Ask User. Before copying the file, asks the user
whether to copy it. If the user chooses Yes and there is a file with 
the same name in the destination directory, overwrites it without 
prompting.

If Does Not Exist. Copies the file only if a file 
with the same name does not exist in the destination directory.

If Newer. Copies the file if it is newer than a file 
with the same name in the destination directory.

If Newer Than Sys. Copies the file if it is newer 
than a file with the same name anywhere in the user's system. If 
the older file is in the destination directory, it is overwritten; if it is 
anywhere else in the system, it is not overwritten or deleted. In 
that case, the user will have two files with the same name in 
different directories.

Make Backup. If there is a file with the same 
name in the destination directory, makes a backup copy (with the 
extension .BAK) before copying the new file.

Destination Directory Displays the path to which the file should be copied during 
installation. The user will not be able to alter this path. Each file 
can be copied to a different destination directory. You can use 
directory placeholders in the path.

Insert Directory Opens the Insert dialog box, which allows you to insert a 
directory placeholder in the path. Before you can insert a 
placeholder, the insertion point must be in the Destination 
Directory box.



Choose Files dialog box
Reference information

The Choose Files dialog box allows you to select files to include with a component.

Option Description
File Name Specifies the file name. Select a file by typing in name, or by 

selecting one from the list.
List Files Of Type Indicates the type of files that is displayed in the File Name box. 

The default is all files (*.*).
Directories Displays the default path. Change the directory by selecting a 

new path from the Directories box, which lists all directories 
available on the current drive. To change the drive, make a 
selection in the Drives box.

Drives Lists the available drives. Selecting a new drive changes the 
contents of the Directories box and the files in the File Name list.

Selected Files The list of files selected for the current component.
Add Adds the files selected in the File Name list to the current 

component.
Add All Adds all files in the File Name list (not just selected files) to the 

current component.
Remove Removes a file selected in the Selected Files list from the current 

component.

Note    If you want to assign an icon to the component that will be displayed in a Windows Program Manager group
when the application is installed, be sure to include the .BMP or .ICO file you need as part of the component.



Setup Manager (PM Icons tab)
Reference information

The PM Icons tab allows you to set up Program Manager groups and items for components in your application. 
You can assign components in your application to Progam Manager Groups on the user's system, and specify 
Program Items, icons, and command lines for each component. For example, if your application consists of three 
components (main, Help system, and tutorial), you can use this tab to set up the three icons that appear on the 
users system and specify what commands are executed when the user clicks any of the three icons.
Note The Setup Manager dialog box tabs only appear in Expert mode.

Note Click a tab below to see its options.

Option Description
Program Icons Displays the list of icons you have specified. Each line in this list 

represents the icon you have selected for one of the components 
in your application. Typically, you have one icon for each 
component of your application.
To add a Program Icon, click Add, then enter information in the 
fields in the bottom half of the window. To edit an existing line, 
select it in this list, then edit the details in the bottom half of the 
window.

Add Adds a new line to the Program Icons list.
Remove Removes the Program Icon selected in the Program Icons box. 
Installed With Component Specifies the name of the component to which you are assigning 

a Program Icon. Choose <<Always Install>> for the base 
component of your application. If you choose a component from 
this list, the Setup program creates a Program Icon in the 
specified group only if the user chooses to install that component.

Program Group Specifies the Windows Program Manager Group on the user's 
system in which the selected icon will appear. If you specify a 
group name that doesn't exist on the user's system, the Setup 
program will create it.

Change Icon Opens the Change Icon dialog box, which allows you to assign a 
Program Item icon to the component. You can choose any bitmap
(.BMP) or icon (.ICO) file, but that file must appear in the list of 
files for the selected component. If you do not choose an icon, 
the Program Manager default icon appears.

Icon Description Specifies the label that will appear under the Program Item icon. 
Corresponds to the Description box in the Windows Program 
Manager Program Item Properties dialog box.

Icon Index Specifies which icon to display if the icon file you have chosen 
contains more than one icon. Click the up or down arrow to set 
the index number for the icon you want (0 for the first one, 1 for 
the second one, and so on).

Command Line Specifies the command line associated with the Program Item 
(including a specific path and file, if desired) used to launch the 
application. Corresponds to the Command Line box in the 
Windows Program Manager Program Item Properties dialog box. 
You can use directory placeholder if necessary.

Insert Directory Opens the Insert dialog box, which allows you to insert a 
directory placeholder in the path. Before you can insert a 
placeholder, the insertion point must be in an editable field.





Reference information
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Setup Manager (Configuration tab)
Reference information

The Configuration tab enables you to specify changes that will be made to the user's AUTOEXEC.BAT, 
CONFIG.SYS, and .INI files during installation. Changes to .INI files are made without prompting the user. Before 
making changes to AUTOEXEC.BAT and CONFIG.SYS files, SETUP.EXE asks users if they want to make the 
changes.
The Setup Manager changes the boxes that appear in the bottom half of the dialog box according to whether you 
are specifying changes to the AUTOEXEC.BAT, CONFIG.SYS, or .INI file.
Note The Setup Manager dialog box tabs only appear in Expert mode.

Note Click a tab below to see its options.

Option Description
Configuration File Changes Displays a list of file changes you have specified. To add a file 

change specification, click Add, then enter information in the fields 
in the bottom half of the window.

Add Adds a new item to the Configuration File Changes list.
Remove Removes the selected file change specification from the 

Configuration File Changes box.
INI File
AUTOEXEC.BAT
CONFIG.SYS

Select the type of file for which you are specifying changes. The 
remaining boxes in the window change according to what type of 
file you have selected.

Installed with Component Specifies the name of the component for which the file change is 
made. Choose <<Always Install>> to make the change 
always. If you choose a component from this list, the Setup 
program makes the specified file change only if the user chooses 
to install that component.

File Name (INI file) Select or enter the path and name of the .INI file to be changed. 
You can use directory placeholders in the path. If the .INI file you 
specify does not exist on the user's system, the Setup program will
create it.

Section (INI file) Specify the section of the specified .INI where the new line is to be
added. If the section does not exist in the .INI file, SETUP.EXE 
creates it. For example, in

[User Information]
Name=Fred J. Magruder

[User Information] is the section.

Entry (INI file) Specify the item to be added to the .INI file. For example, in

[User Information]
Name=Fred J. Magruder

Name is the entry.

Value (INI file) Specify the value of the entry. For example, in

[User Information]
Name=Fred J. Magruder

Fred J. Magruder is the value.

Add To Comma-Separated Indicate whether if the specified entry exists in the .INI file, the 



List (INI file) new value should be added at the end, separated with a comma. If
the specified entry does not exist, it will be added with the value 
you specified.

AUTOEXEC 
(AUTOEXEC.BAT)

Specifies the list to be added to the AUTOEXEC.BAT file if the 
component is installed.

CONFIG (CONFIG.SYS) Specifies the list to be added to the CONFIG.SYS.BAT file if the 
component is installed.

Insert Directory Opens the Insert dialog box, which allows you to insert a directory 
placeholder in the path. Before you can insert a placeholder, the 
insertion point must be in an editable field.



Reference information
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Setup Manager (Launch EXE tab)
Reference information

The Launch EXE tab allows you to specify commands to execute or messages to display after installation is 
complete. For example, you could open Notepad and display a README file, launch a third-party installation 
routine for a device driver, or display a message reminding users to register their software.
Commands can be associated with components, so that the command is executed only if the user chooses to 
install the component. You can specify any number of commands (up to a total of 1000 characters in the command
lines). The first command is executed as soon as the installation is complete, and each subsequent command is 
executed when previous one finishes.
Note The Setup Manager dialog box tabs only appear in Expert mode.

Note Click a tab below to see its options.

Option Description
Command Lines To Execute 
After Installation

Displays a list of commands to be executed. To add a command, 
click Add, then enter information in the fields in the bottom half of 
the window.

Add Adds a new item to the Command Lines To Execute After 
Installation list.

Remove Removes the selected command from the Command Lines To 
Execute After Installation box.

Launch Executable After 
Installation

Specifies that you are adding a command. If you click this button, 
Setup Manager displays the Command box at the bottom of the 
dialog box.

Display Message Box After 
Installation

Specifies that you are entering text to display. If you click this 
button, Setup Manager displays the Message Box Text box at the 
bottom of the dialog box.

Installed With Component Specifies the name of the component that controls whether the 
command is executed or the message is displayed. Choose 
<<Always Install>> to execute the command or display the 
message always. If you choose a component from this list, the 
Setup program executes the command or displays the message 
only if the user chooses to install that component.

Command Specifies the command to execute, including a path if necessary. 
You can use a directory placeholder in the line.

Message Box Text Specifies the text to appear in the message box. The message can 
contain up to 32,000 characters.

Insert Directory Opens the Insert dialog box, which allows you to insert a directory 
placeholder in the path. Before you can insert a placeholder, the 
insertion point must be in an editable field.



Reference information
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Setup Manager (Create Disks tab)
Reference information

Use this tab to build compressed, installable files from the files for your components. You specify the size of the 
disk on which you intend to distribute the application, and the Setup Manager builds compressed files to fit. For 
example, you can have the Setup Manager create compressed files to fit on a 720K or 1.44MB disks. (You can 
also create compressed files for distributing your application across a network.)
When you have finished creating compressed files, you can copy them to a set of master disks.

The Setup Manager names the first compressed installation file after the .ASU file, but with the extension .001 
instead of .ASU. Subsequent files have the same name with extensions .002, .003, and so on. For example, if 
the .ASU file is named TICKETS.ASU, the first compressed installation file will be named TICKETS.001, the 
second will be TICKETS.002, and so on. These are not the names that will be used for the application files when 
they are decompressed and written to the user's disk.
Note The Setup Manager dialog box tabs only appear in Expert mode.

Note Click a tab below to see its options.

Option Description
Drive And Directory For 
Compressed Installation Files

Specifies the path and name of the directory where you want 
SETUPMGR.EXE to place the compressed installation files.

Choose Opens the Choose Directory dialog box to allow you to specify 
the drive and directory for the compressed files.

Compressed Installation File 
Size

Specifies the size for the compressed installation files (usually 
the same as the size of the distribution media). The default is 
Space Available, which means that SETUPMGR.EXE writes until 
the destination disk is full, then requests another disk if 
necessary. If you choose a specific size, SETUPMGR.EXE limits 
all files to that size. If you plan to distribute your application on 
CD-ROM, choose Space Available and use a hard disk with 
enough empty space as the destination drive. SETUPMGR.EXE 
will create one large file, which you can then use for mastering 
CD-ROM disks.

Create Compressed Installation 
Files

Creates the compressed installation files and writes them to the 
destination directory you specified.

Copy Compressed Installation 
Files To Disks

Copies the compressed installation files, including SETUP.EXE, 
the .ASU file, and installation bitmaps, to floppy disks. The 
system requests additional disks as necessary.



Reference information
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About directory placeholders
Using the Asymetrix Setup Utility

Directory placeholders are strings that represent directory names that are available only when the user is installing
your application. During installation, directory placeholders are replaced by the actual path and directory name 
entered by the user or determined by SETUP.EXE.
The directory placeholder strings are:
$windows$ Path name of the Windows directory on the user's computer.
$system$ Path name of the Windows system directory on the user's computer.
$install$ Path name of the directory which the user has chosen as the destination directory.
$source$ Path name of the directory from which SETUP.EXE was started.
$common$ Path name of the directory in which the ToolBook or Multimedia Runtime ToolBook files will be 

installed.

To insert a placeholder, click the Insert Directory button, then click the appropriate button in the Insert dialog box.



Installation script layout
Reference information

The installation script is saved in an .ASU file and is read by the Setup program (SETUP.EXE) to determine how to
display installation dialog boxes and menus. The .ASU file is a Windows-compatible profile file containing the 
following sections.

Section Information
[General] General installation information such as the installation dialog box title, backdrop option, 

and installation bitmap name.
[Component<n>] Contains installation instructions for a optional parts of the application (one section per 

optional component).
[CommonComponent] Contains information about installing Runtime versions of ToolBook or Multimedia 

ToolBook.
[DefaultComponent] Contains instructions that are always carried out if the user installs any part of the 

application.

A typical script is shown below. Key parts of the script are hotspots you can click for more information.
[General]
Title=The Ticket Kiosk
Background=Blue,Tiled,C:\TOOLBOOK\BITMAPS\COAST.BMP
Directory=c:\tickets
Splash=C:\TOOLBOOK\BITMAPS\TREE.BMP,3000
ArchiveName=KIOSK2
RegistrationINI=$Windows$\asym.ini,Registered Apps
FullInstallBMP=DEFAULT
Common=MTB30,$windows$\asym\setup,3.0,United States

[Component0]
Name=Ticket Sales
TotalSize=83114
File0=ticksale.tbk,$Install$,c:\toolbook\setup,AskUser
File1=tb30pdx.dll,$Install$,c:\toolbook,AlwaysCopy
File2=irpcx9.flt,$Install$\ticksale,c:\toolbook\filters,AlwaysCopy
File3=credit.ico,$Install$,c:\toolbook\icons,AlwaysCopy
PMGroupItem0=Ticket Kiosk,$Install$\,Ticket Sales,$Install$\SALE.ICO

[Component1]
Name=Event Calendar
TotalSize=240262
File0=calendar.tbk,$Install$,c:\toolbook\setup,AskUser
File1=dl_inf01.bmp,$Install$,c:\toolbook\setup,AlwaysCopy
File2=dl_inf02.bmp,$Install$,c:\toolbook\setup,AlwaysCopy
File3=dlgs.dll,$Install$,c:\toolbook\setup,AlwaysCopy
File4=calendar.ico,$Install$,c:\toolbook\icons,AlwaysCopy
PMGroupItem0=Ticket Kiosk,$Install$\,Event Calendar,$Install$\CALENDER.ICO
Ini0=$Install$\mmfiles.ini,Sounds,Dir1,$Install$\media\sounds

[Component2]
Name=Seating Chart
TotalSize=157887
File0=seatchrt.tbk,$Install$\seating,c:\toolbook\setup,AlwaysCopy
File1=xlcall.dll,$Install$,c:\excel,AlwaysCopy
File2=readme.txt,$Install$,c:\excel,AlwaysCopy
File3=butnprop.bmp,$Install$,c:\tb_hlp,AlwaysCopy
File4=chkprop.bmp,$Install$,c:\tb_hlp,AlwaysCopy
File5=iconprop.bmp,$Install$,c:\tb_hlp,AlwaysCopy
File6=lftsign.ico,$Install$,c:\toolbook\icons,AlwaysCopy



PMGroupItem0=The Ticket Kiosk,$Install$\,Seating Chart,$Install$\LFTSIGN.ICO
Ini0=$Install$\mmfiles.ini,AVI,Dir1,$Install$\media.avi

[CommonComponent]
Name=MMTB runtime
TotalSize=2623135
File0=mtb30bas.dll,$Common$,C:\TOOLBOOK,IfNewer
File1=mtb30run.exe,$Common$,C:\TOOLBOOK,IfNewer
File2=mtb30cmp.dll,$Common$,C:\TOOLBOOK,IfNewer
File3=mtb30flt.dll,$Common$,C:\TOOLBOOK,IfNewer
File4=mtb30utl.dll,$Common$,C:\TOOLBOOK,IfNewer
File5=mtb30net.exe,$Common$,C:\TOOLBOOK,IfNewer
File6=mtb30lnl.dll,$Common$,C:\TOOLBOOK,IfNewer
File7=mtb30mm.dll,$Common$,C:\TOOLBOOK,IfNewer
File8=mtb30bmp.dll,$Common$,C:\TOOLBOOK,IfNewer
File9=tbload.exe,$Common$,C:\TOOLBOOK,IfNewer
File10=mtb30mm.ini,$Common$,C:\TOOLBOOK,IfNewer
File11=pcdxbmp.dll,$Common$,C:\TOOLBOOK,IfNewer
File12=pcdlib.dll,$Common$,C:\TOOLBOOK,IfNewer
File13=photo.dll,$Common$,C:\TOOLBOOK,IfNewer
Autoexe0=path=$Common$,%path%

[DefaultComponent]
Autoexec0=set path=$Install$,%path;
Action0=$Windows$\notepad.exe $Install$\readme.txt
Message0="Thanks for using The Ticket Kiosk. Please send in your registration card right away, and
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Action instruction
An instruction that will be carried out after installation is complete. You can add as many action instructions as you 
need; they will be carried out in the order listed.
For example, the following action instruction causes the Setup program to start the Notepad application found in the 
user's Windows directory and open the README.TXT file in the destination directory.
Action0=$Windows$\notepad.exe $Install$\readme.txt



Archive name
The root name of the compressed distribution files. Each file will have this name and an extension such as .001, .002,
and so on.



Background



Button bitmaps
The Setup Manager automatically specifies a default bitmap to be used on the Full, Custom, and Exit buttons in the 
Installation Options dialog box. However, you can specify your own bitmaps for these buttons by entering one or more
of the following lines in the [General] section of the .ASU file.

Script line Description
FullInstallBMP=<bitmap 1 path\name> Specifies the bitmap for the Full installation button
CustomInstallBMP=<bitmap 2 path\name> Specifies the bitmap for the Custom installation button
ExitInstallBMP=<bitmap 3 path\name> Specifies the bitmap for the Exit button

The parameter <bitmap n path\name> is the path and name of the bitmap.



CommonComponent
The component that contains instructions for installing the ToolBook or Multimedia Runtime ToolBook files. This 
component is created automatically when you click the button labeled Add Common Multimedia Runtime ToolBook 
Component on the Files tab. If you create a Multimedia Runtime ToolBook component manually (by specifying the 
files yourself), the component is labeled [Component <n>] like any other.



Component
A self-contained part of your application. Many applications consist of a default component that is always installed, 
and one more optional components. If you set up optional components, the user can choose whether to install them 
using a dialog box during Setup. Each component can have its own icon in the application's Program Manager group.



Component <n>
A component section contains installation instructions for an optional portion of the application. There is a 
[Component] section for each component of the application; <n> represents the number of the component.



Configuration change

A change to an .INI file that will be made if the user chooses to install this component.



Configuration change
A configuration change that will be made if the user installs any part of the application.



DefaultComponent
Contains installation instructions that will be carried out if the user installs any part of the application. This component 
can contain the same kinds of instructions as any other component, but File<X>, Name, TotalSize, and 
Query items are ignored at installation.



Destination directory
The default destination directory. The application files (but not necessarily ToolBook or Multimedia Runtime ToolBook 
files) will be installed in this directory unless the user selects another one.



File <n>



General
The General section of the script includes installation instructions that apply to all components, plus information about
graphics that appear during installation.



Message
A message that will be displayed after installation is complete. The message is one line of text in the installation 
script; depending on the editor you use to display the .ASU file, you may have to scroll to see the entire message.



PM group



Registration information
Information that will be added to the ASYM.INI file to register ToolBook or Multimedia Runtime ToolBook. In addition 
to the version and language of Runtime ToolBook, it contains the default destination path specified on the General 
tab. If the user changes that path, the actual path will be written to the ASYM.INI file.



Registration path
The path to the .INI file where ToolBook or Multimedia Runtime ToolBook should be registered. SETUPMGR.EXE 
adds this line automatically.



Splash



ToolBook or Multimedia Runtime ToolBook files
The files required for ToolBook or Multimedia Runtime ToolBook.

 



Technical Support
Help menu

You can receive Asymetrix Technical Support in a variety of ways. Click a topic below for step-by-step instructions 
about Technical Support.

Calling Technical Support
Using the Fax Back System
Using America Online
Using CompuServe
Using Internet
Using the Asymetrix Bulletin Board System (BBS)
Using the World Wide Web



Calling Technical Support
Step by step

Registered Asymetrix product users receive 30 days of complimentary technical support, beginning with their first 
call to Asymetrix Technical Support. Phone support can be extended beyond the complimentary period by 
purchasing a technical support contract.
Use the appropriate Asymetrix technical support telephone numbers for your location as listed below.

Australia/Asia Pacific

    Infotainment Asia Pacific Pty Ltd.
(61+3) 5255-471 (direct)
(61+3) 5255-482 (fax)

9 a.m. to 6 p.m. Eastern Standard Time

    XLTECH Pty Ltd.
(61+2) 9752-111 (direct)
(61+2) 9752-167 (fax)

9 a.m. to 6 p.m. Eastern Standard Time

Europe (except France, Germany, and United Kingdom); Middle East; Africa; 
Russia

(44) 1923-208433
(44) 1923-208419 (fax)

9:00 to 17:00 GMT

France
05-90-83-19 (freephone)
(44) 1923-208419 (fax)

9:00 to 17:00 GMT

Germany
01-30-81-27-07 (freephone)
(44) 1923-208419 (fax)

9:00 to 17:00 GMT

United Kingdom
0800-716957 (freephone)
(44) 1923-208419 (fax)

9:00 to 17:00 GMT

U.S.A. and rest of world
(206) 637-1600 (direct)
(206) 454-0672 (fax)

6 a.m. to 6 p.m. Pacific time, Monday through Thursday; 6 
a.m. to 3 p.m. Friday

When you call Technical Support, please be at your computer with your Asymetrix documentation and have the 
following information:

Your Asymetrix product serial number (found on the first installation disk, your license agreement 
envelope, or your Asymetrix product box).

The version of the Asymetrix product you are running.

Your system configuration information (you can find this information by choosing System Info from 
the Help menu, or by double-clicking the System Info icon in the Asymetrix product program group, located in the 
Program Manager; or by double-clicking Windows Setup, located in the Program Manager in the Main group).

The exact wording of any error message you have encountered.

What happened and what you were doing when the problem occurred.

How you tried to solve the problem.
When you leave a message or send a fax, please include the information listed above. A technical support 
representative will respond within two business days to messages sent and faxes left before or after business 
hours.
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Using the Asymetrix Bulletin Board System (BBS)
Step by step

You can receive online technical support on the Asymetrix Bulletin Board System (BBS) by leaving a message for 
the Asymetrix System Operator. The System Operator checks the BBS daily for new messages and answers them 
within two business days (Monday through Friday). To help the System Operator answer your question, gather 
information about your system as described in Step 5 below.
The data configuration for the BBS is: no parity, 8 data bits, 1 stop bit.

To connect to the Asymetrix Bulletin Board System:
1 Call the Asymetrix BBS number:

If you have a 1200 to 9600 baud modem (v.32bis), call (206) 451-1173.

If you have a 9600 to 14,400 baud modem (v.32bis), call (206) 451-8290.
2 Enter your first and last names at the prompts.

If you are a new BBS user and you see a welcome message, there is probably another user with the same 
name. Hang up the phone, redial, and use a different name, such as "Jim" instead of "James," or include your 
middle initial.

3 Enter your password, then retype it to confirm its spelling.
4 If you are a new user, complete the new user questionnaire.

Make sure you have your Asymetrix product serial number (found on the first installation disk, your license 
agreement envelope, or your Asymetrix product box). You will be asked about your software and hardware. 
Where applicable, it is recommended that you accept the defaults.

5 To leave a message for the System Operator, type C for "Comments to the sysop," then leave a message 
containing the following information:

All the information gathered about your system configuration. For details on gathering this 
information, see instructions below.

The version of DOS you are running.

The version of Windows you are running.

The version of the Asymetrix product you are running.

The exact wording of any error message you have encountered.

What happened and what you were doing when the problem occurred.

How you tried to solve the problem.
6 To log off the BBS, type G for "Goodbye," then type Y to confirm.

Tip At any time, you can type "?" to get online command help. If you have any problems or difficulties with the 
Asymetrix BBS, leave a message for the BBS System Operator or call the Asymetrix Technical Support line at 
(206) 637-1600.

To gather system configuration information for the System Operator:
1 Choose System Info from the Help menu. If you cannot run your Asymetrix product, double-click the System 

Info icon in the product's program group, located in the Program Manager.
2 Copy down all the information listed in the System Status box.
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Using CompuServe
Step by step

If you are a CompuServe member, you can receive online technical support by leaving a message for the 
Asymetrix Forum Moderator. The Forum Moderator checks CompuServe daily for new messages and answers 
them within two business days (Monday through Friday). To help the Forum Moderator answer your question, 
gather information about your system as described in Step 3 below.
Refer to your CompuServe documentation for step-by-step instructions for logging onto CompuServe, leaving 
messages for the Forum Moderator, and logging off CompuServe.

To connect to CompuServe:
1 Log on to CompuServe.
2 To connect to

Windows Third Party Developer A forum, Section 1, type GO ASYMETRIX or GO WINAPA at the 
prompt.

Multimedia Vendors forum, Section 15, type GO MULTIVEN at the prompt.

IBM Ultimedia Tools A forum, Section 5, type GO ULTIATOOLS at the prompt.
3 In the Asymetrix section (Section 1), leave a message for the Forum Moderator containing the following 

information:

All the information gathered about your system configuration. For details on gathering this 
information, see instructions below.

Your Asymetrix product serial number (found on the first installation disk, your license agreement 
envelope, or your Asymetrix product box) and version.

The version of DOS you are running.

The version of Windows you are running.

The exact wording of any error message you have encountered.

What happened and what you were doing when the problem occurred.

How you tried to solve the problem.
4 Log off CompuServe.

To gather system configuration information for the Forum Moderator:
1 Choose System Info from the Help menu. If you cannot run your Asymetrix product, double-click the System 

Info icon in the product's program group, located in the Program Manager.
2 Copy down all the information listed in the System Status box.
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Using America Online
Step by step

If you are an America Online member, you can receive online technical support by leaving a message for the 
Asymetrix Forum Moderator. The Forum Moderator checks America Online daily for new messages and answers 
them within two business days (Monday through Friday). To help the Forum Moderator answer your question, 
gather information about your system as described in Step 3 below.
Refer to your America Online documentation for step-by-step instructions for logging onto America Online, leaving 
messages for the Forum Moderator, and logging off America Online.

Note America Online operates a text telephone (TDD) for deaf or hearing-impaired members.

To connect to America Online:
1 Log on to America Online.
2 Do one of the following:

From the Go To menu, select Keyword, then type Asymetrix.

Go to the Computing and Software area, select Industry Connection, then select Asymetrix.
3 Leave a message for the Forum Moderator containing the following information:

All the information gathered about your system configuration. For details on gathering this 
information, see instructions below.

Your Asymetrix product serial number (found on the first installation disk, your license agreement 
envelope, or your Asymetrix product box) and version.

The version of DOS you are running.

The version of Windows you are running.

The exact wording of any error message you have encountered.

What happened and what you were doing when the problem occurred.

How you tried to solve the problem.
4 Log off America Online.

Tip You can receive the software required to use America Online at no cost, plus five complimentary hours of 
online time. For details about America Online, call (800) 827-6364 or (703) 893-6288.

To gather system configuration information for the Forum Moderator:
1 Choose System Info from the Help menu. If you cannot run your Asymetrix product, double-click the System 

Info icon in the product's program group, located in the Program Manager.
2 Copy down all the information listed in the System Status box.



Step by step
Calling Technical Support
Using CompuServe
Using Internet
Using the Asymetrix Bulletin Board System (BBS)
Using the Fax Back System
Using the World Wide Web



Using Internet
Step by step

If you have access to Internet mail, you can receive online technical support by leaving a message for the 
Asymetrix Forum Moderator. The Forum Moderator checks Internet daily for new messages and answers them 
within two business days (Monday through Friday). To help the Forum Moderator answer your question, gather 
information about your system as described in Step 3 below.
Refer to your electronic mail documentation for step-by-step instructions about starting mail and sending 
messages on Internet.

To access Internet:
1 Start your electronic mail application.
2 In the box where you enter the receiver's address, type support@asymetrix.com or 

techsup@asymetrix.com.
3 Leave a message for the Forum Moderator containing the following information:

All the information gathered about your system configuration. For details on gathering this 
information, see instructions below.

Your Asymetrix product serial number (found on the first installation disk, your license agreement 
envelope, or your Asymetrix product box) and version.

The version of DOS you are running.

The version of Windows you are running.

The exact wording of any error message you have encountered.

What happened and what you were doing when the problem occurred.

How you tried to solve the problem.
4 Send your message.

To gather system configuration information for the Forum Moderator:
1 Choose System Info from the Help menu. If you cannot run your Asymetrix product, double-click the System 

Info icon in the product's program group, located in the Program Manager.
2 Copy down all the information listed in the System Status box.
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Using the Fax on Demand System
Step by step

If you have a fax machine, you can receive answers to frequently asked questions from the Asymetrix Fax on 
Demand System, which is available 24 hours a day.

To use the Fax on Demand System:
1 From your fax machine or regular phone, dial (800) 770-5444 or (206) 637-5833.
2 If you do not have a list of available fax documents, or if the list you have is old, follow the directions in the Fax 

on Demand System's recording to receive a list. The list is updated frequently.
If you have a current list of available documents, follow the directions in the Fax on Demand System's recording
to receive up to three fax documents.

3 If you are calling from a regular phone, the Fax Back System will prompt you to enter your fax machine phone 
number. Enter a '"1" and your area code, followed by your phone number.
If you are calling from a fax machine phone, the system will automatically fax to that number.
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Using the World Wide Web
Step by step

If you are have access to the World Wide Web (WWW), you can receive online technical information and technical
support at the Asymetrix Web site. The Asymetrix Internet Tech Center Web page provides access to

answers to frequently asked questions (FAQ), organized by product.

the Asymetrix FTP (file transfer protocol) site, which includes an index of the names, size, details, 
and locations of all Asymetrix FTP files.

Asymetrix online technical support, where you can leave a message. You message will be 
answered within two business days (Monday through Friday).

To access the Asymetrix web site:
1 Load your Windows Web browser (for example, NetScape or Mosaic).
2 Enter the location (URL) of the Asymetrix web site:

http://www.asymetrix.com.

To reach the Asymetrix Internet Tech Center Web page:
1 Click the Technical Services button on the Asymetrix main menu graphic.
2 Click the "Internet Tech Center" hyperlink.
3 Click the appropriate hyperlink to go to FAQ, the Asymetrix FTP site, or technical support.
4 If you click the "Submit a problem or suggestion to Asymetrix's Technical Support" hyperlink to go to technical 

support, enter your contact information, as well as the details of your problem, including the following 
information:

All the information gathered about your system configuration. For details on gathering this 
information, see instructions below.

Your Asymetrix product serial number (found on the first installation disk, your license agreement 
envelope, or your Asymetrix product box) and version.

The version of DOS you are running

The version of Windows you are running

The exact wording of any error message you have encountered

What happened and what you were doing when the problem occurred

How you tried to solve the problem
To gather system configuration information for the Forum Moderator:
1 Choose System Info from the Help menu. If you cannot run your Asymetrix product, double-click the System 

Info icon in the product's program group, located in the Program Manager.
2 Copy down all the information listed in the System Status box.
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